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1995). To isolate the infl uence of one mouse on a social interaction, 
assays testing social approach use a three-chambered box in which 
a mouse chooses between interacting with a restrained mouse or 
an inanimate object (Landauer and Balster, 1982; Pomerantz et al., 
1983; Carter et al., 1995; Winslow, 2003). Social approach data is 
collected by noting how much time the mouse spends in each of 
the three chambers, and comparing the amount of time the mouse 
spends in the chamber with the stimulus mouse to the time spent 
with the inanimate object. These data can be collected in a number 
of ways: by a trained observer viewing chamber crossings (Brodkin 
et al., 2004; Brigman et al., 2009), by counting infrared beam breaks 
between chambers of the apparatus (Nadler et al., 2004), or by 
using video recording and computer software to track the mouse’s 
movement in the apparatus  (Kwon et al., 2006; Tabuchi et al., 2007; 
Blundell et al., 2009). The ability to track a mouse’s movements 
allows a more sensitive output, as behaviors may be recorded in 
addition to chamber crossings. Various tools exist to study mouse 
behavior which can track mouse movement during social approach. 
Software packages such as Ethovision (Noldus), SMART Triwise 
Video Tracking (Harvard Apparatus), or VideoMot2 (TSE), have 
features which allow the user to track movement and specifi c 
aspects of mouse behavior such as motion, rearing, head orien-
tation, measure interactions between multiple mice, and some 
(Ethovision) are able to detect behaviors such as grooming, fi ght-
ing, or tail rattling. These tools offer many options for analyzing 
video recorded animal behavior, however, commercially available 
tools may be prohibitively expensive for individual researchers or 
small laboratories. A number of free programs exist that may be 
used for video analysis of social behavior, such as ImageJ1 (Nakajima 

INTRODUCTION
In the study of social behavior and neuropsychiatric disease, the 
mouse has become an increasingly popular tool for understanding 
how brain mechanisms infl uence behavioral phenotypes, and the 
number of transgenic mouse models of human disorders available 
to researchers has risen sharply (Takao et al., 2007). By studying 
the contribution of individual genes, or the interaction between 
genes and environment to behavior in animal models, it is pos-
sible to uncover the mechanisms by which behavior is altered 
in human neuropsychiatric disease (Tecott, 2003). Complex 
behaviors such as aggression, social preference, social memory, 
maternal care, anxiety, juvenile play and same- and opposite-sex 
interactions have been studied in mice (Pomerantz et al., 1983; 
Mondragon et al., 1987; Laviola et al., 1994; Griebel et al., 2000; 
Blanchard et al., 2001; Ferguson et al., 2001; Long et al., 2004; 
Rodriguiz et al., 2004; Moretti et al., 2005; O’Tuathaigh et al., 
2007; Wersinger et al., 2007), giving insight into the neurobiology 
of social behavior. In studying mouse models of disorders such 
as schizophrenia, autism, or William’s syndrome, social behaviors 
are particularly important for testing face validity of a model 
(Crawley, 2004) and provide an opportunity to assess the effi cacy 
of therapeutics.

A commonly assayed social behavior involves quantifying the 
tendency for male and female mice to investigate an unfamiliar 
mouse through mutual sniffi ng, grooming, or following (Wills 
et al., 1983; Blanchard and Blanchard, 2003). This social interac-
tion can be measured by observing two mice interacting freely in 
an open fi eld (Cutler, 1991; Shi et al., 2003), however, in the labora-
tory this approach can make it diffi cult to determine which mouse 
initiates social contact, and may be confounded by undesired inter-
actions such as aggression or mounting (Winslow and Camacho, 
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et al., 2008; Nakatani et al., 2009; Tanda et al., 2009) and WinTrack2. 
These programs allow users to write custom scripts for specialized 
applications. It would be advantageous if standardized tests and 
analysis methods for social interaction phenotypes were available to 
laboratories carrying out mouse behavioral phenotyping batteries 
for comprehensive studies of mouse models of human disease (van 
der Staay and Steckler, 2001; Solberg et al., 2006; Crawley, 2007); 
such methods must be inexpensive, easy to implement, and allow 
for reproducibility between users and laboratories.

Here we present a novel, rapid and fl exible computer-assisted 
method for analyzing social approach data collected by video, 
using scripts written for an image analysis program freely available 
from the National Institutes of Health (NIH). Using this method, 
a mouse can be tracked as it moves within chambers, as well as 
between chambers. We present social approach data on C57BL/6 
mice, a frequently studied inbred strain shown to exhibit high 
levels of sociability in social approach assays (Moy et al., 2007). 
We show that the computer-assisted automated scoring method is 
comparable in accuracy to a trained human observer, and present 
a method of analysis of the social perimeter as a measure of direct 
social interaction within the chambers.

MATERIALS AND METHODS
ANIMALS
Mice used as test subjects in social approach were experimen-
tally naïve 8 week old male C57BL/6 mice obtained from Taconic 
(Hudson, NY, USA) at 7 weeks of age. Unrelated age-matched 
C57BL/6 male mice unfamiliar to the test mice were used as the 
social stimulus. All mice were housed fi ve to a cage throughout 
testing, on a 12-h light/dark cycle, with ad libitum access to food 
and water. Behavioral testing and handling took place during the 
light cycle. Mice were handled by an experimenter for approxi-
mately 5 min a day for 2 days prior to testing. On the day of the 
experiment, mice were moved to the behavior testing room in their 
home cages and allowed to acclimate for 45 min. Mice to be used 
as the social stimulus were placed into the plastic holding cages for 
5 min to acclimate, then removed. Stimulus mice were used in only 
one trial on any given testing day. Experiments were performed 
according to a protocol approved by the Massachusetts Institute 
of Technology Committee on Animal Care and in accordance with 
NIH guidelines.

APPARATUS
The social approach apparatus was built from opaque acrylic sheets 
(US Plastics, Lima, OH, USA) bonded using acrylic solvent (GE 
Polymershapes, Huntsville, NC, USA) to form an open top box 
(Figure 1A). The box measured 24”L × 12”W × 12”H, divided into 
three chambers (8”L × 12”W) by acrylic sheets with 3” × 3” square 
openings cut into them to allow test mice to move between cham-
bers. The sides and partitions of the box were made of black acrylic, 
while the fl oor was made of white acrylic to create a high contrast 
between the fl oor and the dark colored mouse strain used in this 
study. The apparatus was placed in the behavior testing room in 
a position where the box was evenly lit at 300 lux, as tested using 
a light meter (Sekonic). The apparatus chambers were numbered 

FIGURE 1 | Social approach apparatus setup. (A) Schema of social 
approach apparatus, showing dimensions. (B) Placement of video camera for 
recording social approach behavior. (C) Top down view of social approach box, 
with stimulus mouse in chamber 1. Subject mouse shown is interacting within 
the social perimeter, indicated in red. (D) View of subject and stimulus mouse 
interacting in chamber 1.

2http://www.dpwolfer.ch/wintrack/index.html
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1–3 from left to right for reference. Chambers 1 and 3 contained 
cages. The cage in chamber 1 contained a social stimulus mouse 
(Figure 1C); the cage in chamber 3 was left empty as a control. 
The cages used were clear acrylic cylinders measuring 8”H × 4”D 
(US Plastics, Lima, OH, USA) drilled with numerous 1/4” holes 
to a height of 4”. The cylinders were large enough for an adult 
mouse to move about comfortably, and the height and mass of 
the cylinders prevented animals from climbing into or out of the 
cylinder, or from displacing the cylinder during acclimation and 
testing (Figure 1D).

SOCIAL APPROACH
Immediately prior to testing, each subject mouse was acclimated 
to the social approach apparatus. An experimenter placed a subject 
mouse into chamber 2 of the clean empty social approach box, 
allowing it to explore all three chambers for 5 min. Video recordings 
taken during this time were analyzed to test whether mice showed 
chamber preference. At the end of 5 min, the subject mouse was 
removed, and a previously acclimated stimulus mouse was placed 
into the empty cage in chamber 1 of the social approach box. The 
test mouse was replaced in chamber 2 and video recording was 
taken as the test mouse explored the box and cages for 10 min. 
The stimulus mouse held in the cage in chamber 1 was available 
to the subject mouse for visual, tactile, and olfactory contact, but 
only at the initiation of the subject mouse. The subject mouse’s 
activity was videotaped for analysis of time spent in each cham-
ber, and time spent in the “social” and “control” perimeters. At 
the end of the 10-min testing period, the subject and stimulus 
mice were removed and the apparatus and cages were wiped thor-
oughly with Quatricide PV (Pharmacal, Naugatuck, CT, USA) to 
remove odors.

ACQUISITION AND PROCESSING OF DATA
Video acquisition
Video recordings of social approach trials were taken with a digital 
camcorder (Sony Handycam) held directly above the apparatus at a 
height of 3” using a tripod (Manfrotto) (Figure 1B). The position of 
the tripod and the social approach box were fi xed using markings 
on the fl oor of the behavior room, position was checked frequently. 
Correct calibration of camera zoom is essential for downstream 
analysis of videos. To do this, the camera zoom was set so that the 
fl oor of the social approach apparatus fi t precisely into a 120 × 60 
pixel box in the exported video (see below). Videos were recoded at 
320 × 240 pixels, 30 frames per second, using Quicktime Pro 7.1.3 
software (Apple) run on a PowerBook G4 (Apple) laptop compu-
ter with GeForce FX Go5200 graphics card and 512 MB RAM. To 
reduce fi le size to approximately 325 KB, images were exported at 
160 × 120 pixels, 3 frames per second for subsequent analysis, using 
options in Quicktime’s export settings.

Processing of data
(1) Install ImageJ (from the NIH3, installation instructions are 

included) to data processing computer. ImageJ is available 
for Microsoft Windows and Linux operating systems, howe-
ver, the scripts have only been verifi ed using Mac.

(2) Install custom scripts downloaded from http://www.
frontiersin.org/behavioralneuroscience/paper/10.3389/
neuro.08/048.2009/ by moving these seven scripts into the 
folder ImageJ\plugins\Macros.

(3) Load video fi les using the File >Open function. At this stage 
users are given the option of converting video fi les to gray-
scale, this is advised.

(4) Run scripts in order to analyze video (Figure 2). Scripts can 
be accessed from the Plugins >Macros dropdown menu.
• The “Step 1 fi eld selection” script fi le defi nes a 120 × 60 pixel 

box. Place box to precisely fi t the fl oor of the social approach 
apparatus. If the video camera or box position were to acciden-
tally shift during the course of an experiment such that fl oor 
no longer precisely fi ts the 120 × 60 pixel box, the movie fi le 
can be adjusted post-recording using Image >Adjust >Size (to 
correct a problem with zoom) or Image >Rotate >Arbitrarily 
(to correct a problem with rotation).

• The “Step 2 blocking” script blocks out the area of the cages 
and partitions of the apparatus to remove signal from these 
areas in downstream analysis.

• The “Step 3 chamber 1 ROI” script uses ImageJ’s threshol-
ding, noise reduction, and variance fi lters (more infor-
mation about these can be found at http://rsb.info.nih.
gov/ij/docs/menus/image.html) to generate a signal from 
the mouse that can be analyzed against a background with 
minimal noise. The output from the “chamber 1 ROI” 
script is a Z-axis plot of mean gray value signal within 
the region of interest corresponding to chamber 1 for the 
recording time. Copy and paste Z-axis plot to data sheet 
using the “copy” function.

• The “Step 4 chamber 2 ROI” obtains the same informa-
tion from chamber 2, Z-axis plot should be transferred 
to data sheet.

• The “Step 5 chamber 3 ROI” obtains the same informa-
tion from chamber 3, Z-axis plot should be transferred 
to data sheet.

• The “Step 6 social perimeter” and “Step 7 control perimeter” 
scripts generate Z-axis grey value plots for regions of interest 
corresponding to a perimeter centered on the cage in cham-
ber 1 (social perimeter) or chamber 3 (control perimeter), 
which is 1.5 times larger than the circumference of the cage. 
This allows for quantifying the time spent in close proximity 
to the cage, where social interaction is likely to take place, 
as opposed to time spent in the chamber but not in close 
proximity to the cage. Transfer data for each to data sheet.

(5) Review data in data sheet to check for gaps and confl icts as 
described below. After checking for errors, calculate percent 
time spent in each chamber in Excel. We do this by dividing 
the number of frames containing signal for a given ROI by 
the total number of frames for the assay (this should be 1800 
frames for a 10-min movie exported at 3 frames per second) 
and multiplying by 100.

Verifi cation of data and analysis
The “chamber 1 ROI”, “chamber 2 ROI” and “chamber 3 ROI” 
scripts are designed so that the output of these minimizes the occur-
rence of gaps (resulting from no mouse signal in any chamber 3http://rsb.info.nih.gov/ij/

http://www.frontiersin.org/behavioralneuroscience/paper/10.3389/neuro.08/048.2009/
http://rsb.info.nih.gov/ij/docs/menus/image.html
http://rsb.info.nih.gov/ij/
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FIGURE 2 | Computer-assisted scoring of social approach. Processing of social approach movie fi les using ImageJ computer scripts. Scripts are run in order 
shown, data output shows signal in ROI over each frame of video.
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region of interest in a frame, a “disappearing mouse”) and confl icts 
(resulting from signal from the mouse occurring in two chamber 
regions of interest in the same frame, “two mice”). However, both 
gaps and confl icts occur at a low rate and thus the data for all 
regions of interest should be hand-checked for accuracy by review-
ing raw data for errors, and verifi ed by comparing to the original 
video. If a gap is present, caused by the signal for the mouse briefl y 
dropping below threshold, a notation is made to count signal in 
the gap areas. If a confl ict is present, caused by signal for the mouse 
appearing in ROIs for two chambers at the same time (e.g. as the 
mouse moved between chambers), a chamber entry is recorded, 
and signal from the exiting chamber not counted, if the mouse’s 
head and shoulders move into the chamber. After hand-checking 
the data, the number of frames containing mouse signal is summed 
for each chamber and used to calculate percent time spent in each 
chamber over the course of the assay. The percent time spent in 
the social versus control perimeter is calculated by summing the 
number of frames containing mouse signal and dividing this by 
the total number of frames for the video.

Statistics
Analysis of social approach behavior was carried out using one-
way ANOVA, comparing the number of frames containing mouse 
signal between ROIs. Where a signifi cant effect was seen, post hoc 
comparison was performed using Tukey HSD test. The signifi cance 
level was set at P < 0.05. Comparison between hand and compu-
ter-assisted scored social approach data was carried out using 
two-way ANOVA.

RESULTS
To test whether mice run in the social approach apparatus showed 
a chamber preference in the absence of a stimulus mouse, we ana-
lyzed acclimation trials for time spent in chambers 1, 2, and 3. In 
all acclimation trials, mice spent similar amounts of time exploring 
chambers 1 and 3 (Figure 3A), giving evidence that the mice do not 
exhibit chamber preference when a stimulus mouse is not present. 
It would be expected that an inconsistency in light, noise, or odors 
across the three chambers would be refl ected in chamber preference 
during acclimation. An observed side preference that persisted after 
known variables in the apparatus were controlled for would limit 
confi dence in any social approach data resulting from testing. In 
such a situation, the apparatus should be relocated to an area where 
no side preference is seen during acclimation.

During the social approach trials, the addition of a stimulus 
mouse to chamber 1 caused subject mice to signifi cantly alter their 
behavior, spending the majority of the assay exploring the chamber 
containing the stimulus mouse (Figure 3B). The change was con-
sistent, with 11 of the 12 mice tested showing a preference for the 
stimulus mouse in chamber 1. To test the time course of investiga-
tion over the 10-min assay, social approach data were separated into 
four 150 s bins, and time spent in chamber 1 for each bin was meas-
ured. It was found that mice exhibited the most social approach 
behavior during the fi rst 150 s bin, with time spent in chamber 1 
dropping off as the assay progressed (Figure 3C), similar to what 
was found in a previous study  (Nadler et al., 2004). As a test to 
determine how much of the subject mouse’s time in chamber 1 or 
3 was spent investigating the cages, a measure of time spent within 

FIGURE 3 | Social approach data. (A) Data showing social 
approach behavior. All trials use male C57BL/6 mice, tested at 8 weeks of 
age. For (A–C), n = 12, for (D), n = 10. Error bars indicate SEM. (A) Percent 
time spent in chambers 1, 2, and 3 during 5-min acclimation. (B) Comparison 
of computer-assisted scoring and experimenter scoring of 10-min social 
approach trials with stimulus mouse in chamber 1. Signifi cant preference was 
found for percent time spent in chamber 1 compared to chamber 3, *P < 0.05, 
ANOVA within group comparison between chamber 1 and 3. No signifi cant 
difference was found between computer scored and experimenter scored 
data. (C) Time spent in chamber 1 by the subject mouse over the course of 
the 10-min trial, based on computer scored data. The trial was divided into four 
bins of equal length (150 s). The amount of time spent in chamber 1 in bins 2 
and 3 was signifi cantly less than in bin 1, based on ANOVA comparison 
between bins, *P < 0.01 (Tukey HSD test). (D) Percent time spent in social 
perimeter (within chamber 1) compared to control perimeter (within chamber 
3). Signifi cant preference for social perimeter, *P < 0.05, ANOVA within group 
comparison between social and control perimeter.
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a circumference 1.5 times that of the cage was taken for chamber 1 
(“social perimeter”) and chamber 3 (“control perimeter”). For both 
chamber 1 and chamber 3, the majority of time in each chamber 
was spent in proximity to the cage (Figure 3D). These data are 
consistent with other reports that have used similar measurements 
of proximity of the subject mouse to the stimulus mouse (Kwon 
et al., 2006; Tabuchi et al., 2007; Nakajima et al., 2008; Nakatani 
et al., 2009; Tanda et al., 2009).

To verify the accuracy of the computer scripts in measuring the 
time each mouse spent in the chambers, all movies were also hand 
scored by trained researchers. Researchers watched the movie fi le 
and recorded the time at which each chamber crossing took place, 
and summed the time spent in each of the chambers. Within each 
scoring group, there was a signifi cant preference for chamber 1 
(F

(2,71)
 = 154.8, P < 0.001). Importantly, there were no signifi cant 

effect of hand scoring versus computer-assisted scoring of data 
(F

(1,71)
 = 0, P = 1) (Figure 3B).

DISCUSSION
The computer-assisted scoring method for social approach offers 
a standardized way to study social interaction in mouse mod-
els of human disease in a controlled environment while main-
taining the sensitivity to measure the test mouse’s movements 
within the chamber. A concern with any behavioral phenotyping 
test is  reproducibility across laboratories (Crabbe et al., 1999). 
However, social approach assays appear to be reproducible among 
inbred mouse strains across laboratories. To show accuracy and 
reproducibility of the social approach assay in general and the 
 computer-assisted method in particular, we fi rst compared our 
computer-assisted social approach data with hand scored data, and 
found no difference between the two methods. When our results 
are compared to those of other studies examining social approach 
in C57BL/6 mice using three-chambered apparatuses of varying 
dimensions (Crawley et al., 2007; Labrie et al., 2008; McFarlane 
et al., 2008), there was no substantial difference in chamber pref-
erence, even in cases where the mice tested were 5–6 weeks of age 
(Moy et al., 2004), or female (Brodkin et al., 2004). Mice that had 
been subjected to prior behavioral phenotyping such as open fi eld 
anxiety and rotarod muscle coordination tests showed no difference 
in social approach preference when compared to the mice tested 
in this study (Moy et al., 2007), nor were variations noted when a 
mouse of a different strain, such as DBA/2J or A/J, was used as a 
stimulus (Brodkin et al., 2004; Nadler et al., 2004).

It is important to note that other inbred strains tested in social 
approach assays often exhibit different phenotypes: FVB and DBA/2 
mice show preference for chamber 1 similar to that exhibited by 
C57BL/6 mice, while BALB, BTBR, and 129S1 mice tend to be less 
sociable (Moy et al., 2007), so caution must be taken to consider 
background strain when testing or comparing social approach 
behaviors in mouse models of disease. This assay can also be used 
to screen for genetic modifi ers of social behavior. As an example, we 
have tested mice double haploinsuffi cient for the candidate autism 
susceptibility genes Pten and Slc6a4 in an isogenic C57BL/6 back-
ground, and found evidence that these genes interact to infl uence 
social approach behavior (Page et al., 2009).

While the tools presented here do not have the sensitivity to 
measure detailed aspects of social behavior, such as time engaging in 
active sniffi ng, or aggressive behaviors such as tail rattling, the analy-
sis of social perimeter offers a measurement of the time in which 
specifi c social investigation is most likely to occur. The computer-
assisted method of analyzing social behavior data is readily adapt-
able. By altering the computer scripts used for analysis, it becomes 
possible to extract additional data on the test mouse without car-
rying out additional assays. For example, locomotion and distance 
covered in the social approach apparatus can be measured during 
social approach or acclimation, and used to examine differences in 
locomotor activity between genotypes being tested. This computer-
assisted three-chambered social approach paradigm may be repeated 
after a period of separation of subject and stimulus mouse to measure 
social recognition  (Page et al., 2009), and variations could be made 
to the apparatus, such as the use of a red fl oor to create a contrasting 
background for mouse strains with varying coat colors. We have used 
altered versions of the scripts to analyze data gathered on different 
types of behavioral apparatuses, for example measuring thigmotaxis 
in a test of open fi eld anxiety and crossings over a false precipice in 
a visual cliff test of vision (data not shown) and expect that users of 
this method will modify the scripts presented here to optimize for 
their particular needs. Using computer-assisted scoring, previously 
observation intensive behavioral assays can be run in a reproduc-
ible way by laboratories, without the need for expensive proprietary 
software or a large team of trained observers.
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